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Uvod .

Trajanje
Na ovoj radionici polaznik ¢e se upoznati s osnovama uporabe poglavlja:
besplatnog grafickog alata GIMP (Gnu Image Manipulation Program).
10 min

Radionica je namijenjena svim polaznicima koji se do sada nisu imali
prilike susresti s nekim od grafi¢kih alata, a zele nauciti obraditi,
odnosno retusirati neku sliku za seminarski, diplomski ili neki drugi rad.

Za oznacCavanje vaznijih pojmova, naziva naredbi i elemenata sucelja te
naziva drugih objekata koji se nalaze na ekranu, koriste se podebljana
slova.

Put do naredbe pisan je kurzivom, a sama naredba podebljano,
primjerice Tools - Selection Tools > Rectangle Select.

@ srce '
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1. Upoznavanje radnog prostora
programa

Po zavrSetku ovog poglavija polaznik ¢e moci:

e instalirati i pokrenuti program GIMP

e prepoznati tijelove sucelja programa

e podesiti parametre pri stvaranje novog dokumenta

e otvoriti postojecu datoteku te pregledati i objasniti njena svojstva

e zumirati, koristiti ravnalo i pomicne linije.

1.1. Pokretanje i upoznavanje sucelja GIMP-a

1.1.1. Sustavi na kojima je dostupan GIMP i instalacija
programa

GIMP je najpopularnija besplatna aplikacija otvorenoga kéda za
stvaranje i obradu rasterske grafike. Koristi se za retuSiranje, crtanje,
uredivanje slika, pretvaranje slika u razliite formate te za jo$ niz korisnih
amaterskih i profesionalnih zadataka.

GIMP je dostupan za korisnike operacijskih sustava Windows, Mac i
GNU/Linux.

Proces instalacije programa GIMP na sustavima Windows prili€no je
jednostavan.

Potrebno je preuzeti instalacijsku datoteku programa sa stranice
http://www.gimp.org/downloads/. Najlak$e je preuzeti instalacijsku
datoteku odabirom bilo kojeg od dva dolje navedenih linkova.

Download GIMP 3.0.2

via BifTorrent

Nakon odabira, potrebno je instalacijsku datoteku.exe spremiti na
racunalo i pokrenuti. Proces same instalacije slijed je nekoliko osnovnih
opcija koje je potrebno procitati i odabrati one koje odgovaraju
zahtjevima (primjerice odabir jezika).

1.1.2. Pokretanje GIMP-a

Za pokretanje programa u sustavu Windows, odabere se Start > Svi
programi > GIMP. Prilikom prvog pokretanja program ¢e se sporije
otvarati jer podeSava razne opcije, ali ve¢ drugi i svaki sljedeci put
pokretanje ¢e biti puno brze.

Trajanje
poglavlja:

65 min

Zanimljivosti i napomene

Najpoznatiji sustavi za koje
je dostupan program GIMP:
Windows 8, Windows 7,
Windows Vista, Windows
XP, Snow Leopard 10.6X,
Leopard 10.5X, Tiger
10.4X, Debian, Fedora,
Gentoo Portage, Slackware,
OpenSUSE, Ubuntu...

@ srce ’
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Za pokretanje na sustavima Mac, potrebno je odabrati mapu
Applications te potom GIMP.

Za pokretanje GIMP-a na Linux sustavima, klikne se na Applications >
Graphics > GIMP.

1.1.3. Upoznavanje sa suceljem

Kada se pokrene GIMP otvaraju se tri prozora, od ¢ega su lijevi i desni
namijenjeni raznim alatima, dok se u srediSnjem, radnom prozoru,
ureduje slika i pristupa izbornicima.

Osim navedenog nacina rada, postoji i drugi nacin, tzv. Single-Window
Mode, koji omogucéava rad u samo jednom prozoru, $to znaci da se tri
prethodna prozora spajaju u jedan veliki prozor. Za promjenu prikaza iz
tri odvojena prozora u jedan veliki prozor, odabere se u srediSnjem
prozoru izbornik Windows - Single-Window Mode. Ovakav nacin rada
karakteristiCan je i za druge grafiCke alate te je puno prakti¢niji od
uporabe zasebnih prozora. Prozori su ujedno i prilagodljive veli€ine, §to
znaci da se mogu uhvatiti za rub i povecati ili smanijiti, ovisno o potrebi.

1. Toolbox (Kutija s alatima) — prozor koji se nalazi s lijeve strane,
podijeljen na dva dijela. U gornjoj polovici Toolboxa nalaze se
alati kojima se obavljaju razliite radnje u programu, a u donjoj
polovici opcije vezane za trenutno odabrani alat.

2. Sredisnji prozor je radni prozor i u njemu se odvijaju sve radnje
na otvorenoj slici.

) @ srce
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3. Desni prozor sluzi za organiziranje slojeva (engl. Layers),
povijesti (engl. History), palete boja (engl. Color pallete) te sadrzi
razne dodatne opcije koje se ne nalaze u Toolboxu.

1.2. lzrada novog dokumenta

Prije poCetka rada u GIMP-u vazno je znati kako izraditi i otvoriti neku
sliku. Prazna slika koristi se kada se zeli crtati i bojati, a poCetnicima je
korisna za istrazivanje novih alata i svih moguc¢nosti koje nudi Toolbox.

1.2.1. Otvaranje prazne slike

Ako se zeli otvoriti prazna slika, odabere se izbornik File > New nakon
kojeg se otvara prozor Create a New Image.

«d Create a New Image X
Template: v
Image Size

Width: | 1024 -+

Height: | 768 - + px ~

E | = 1024 x 768 pixels
300 ppi, RGB color

» Advanced Options

Help Reset OK Cancel

U ovom izborniku moZe se odabrati veli¢ina prazne slike koja je u gore
navedenom slu¢aju 1024 x 768 px (piksela). Veliina se moze upisati
ruéno, gdje se posebno upisuje Sirina i posebno visina ili se moze
odabrati pomocu okretnog dugmeta.

Osim veli€ine slike, pritiskom na oznaku jedinice odabire se i jedinica
koja se zeli koristiti, a koja ovisi o0 namjeni slike na kojoj se radi. Tako se
mogu odabrati pikseli, in€i, milimetri, centimetri, metri ili neke druge od
ponudenih jedinica. Nakon odabira jedinice, odabire se okomito ili
vodoravno usmjerenje slike.
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«isf Create a New Image X
Template: >
Image Size
Width: 1024 - +
Height: 768 - 1 | pixels v
[§ | [ 1024 x 768 jnches
300 ppi, RGB
millimeters
¥ Advanced Options
points
Help Rese picas Cancel
| centimeters |
meters
feet
yards

typogr. points
typogr. picas

Kada se zavr$i s osnovnim podeSavanjima nove slike, moguce je
odabrati i napredne opcije pritiskom na naredbu Advanced Options ili
na oznaku ,+“ nakon ¢ega se otvara dodatni izbornik.

& Create a New Image X
Template: et
Image Size
Width: 1024 wic|
Height: 768 - + | px T
¥ [ 1024 x 768 pixels
T2 ppi, RGE color

* Advanced Options

X resolution: 72,000 -+ |1

¥ resolution: 72,000 = || i’ pixels/in =~
Color space: RGB color .
Precision: 8-bit integer >
Gamma: Non-Linear v
Color profile: Built-in RGB (GIMP built-in sRGB) ~
Soft-proofing color profile: MNone -

Help Reset oK Cancel

U dodatnom izborniku moze se odabrati X i Y rezolucija slike, koja za
tisak mora biti minimalno 300 ppi (pixels per inch). U gore navedenom
primjeru je 72 ppi.

U izborniku Color space odabrano je RGB color, $to znaci da ¢e novi
radni prostor biti u boji, to¢nije u RGB modelu boja (vise 0 modelima
boja u poglavlju 2.3. Priprema slike za tisak i web, str. 19). Nudi se jo$
opcija Grayscale, odabirom koje radni prostor postaje crno-bijeli.

Izbornik Precision nije postojao u starijim verzijama GIMP-a, a sada,
pomocu ove moguénosti, moze se raditi s mnogo vise informacija o boji i
detaljima na slikama, $to znaci da ova podrska daje moguénost
stvaranja super glatkih prijelaza boja na slici.

i @ srce
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U izborniku Gamma moguce je odabrati izmedu dva ugradena ICC
profila koji se automatski dodjeljuju slici, dok se u izborniku Color
profile moze dodijeliti novi ICC profil na sliku koji je prethodno spremljen
na ra¢unalu.

Jos jedna priliéno vazna opcija u dodatnom izborniku je i izbornik Fill
with gdje se odabire kakva ¢e biti pozadina slike, u boiji ili prozirna.

U komentar se mogu napisati neki op¢i podaci o slici, ali za stvaranje
slike to nije nuzno.

Nakon podes$enih svih postavki, odabere se dugme OK.

1.2.2. Otvaranje fotografije ili slike

Osim stvaranju nove slike, program GIMP namijenjen je i obradi neke
postojece slike ili fotografije. Otvaranje se radi, kao i kod vecine drugih
programa, odabirom izbornika File > Open.

«id GNU Image Manipulation Program

File Edit Select View Image Layer Colors Tools Filters Windows Help
New... Ctrl+N

Create 4
Open... Ctrl+0
Open as Layers... Ctrl+Alt+0

Open Location...

Open Recent 4

Pojavljuje se sko¢ni prozor Open Image u kojem se prikazuje struktura
mapa i podmapa na ra¢unalu. Kada se pronade Zeljena fotografija ili
slika, odabere se i pritisne dugme Open.

] Open bmage o
© Recent 4 Sditipkc WDeskiop Polamik  RAOY_datoteks | Primjer *
= Home N . ' Modif
= ook S — T —
% Documents * Bubamasa i $89kB 1 Hetype 117 .‘
B Downlosds * Buketjpg I524K8  IPEGImage a7 ‘
* Djvoka PG 2BMB  IPEG Image a7 L]
= Music
S Dvosacjpg 1.0M8 IPEG Image 17 Balonl PG
ctures n 5 \ :

Hipater PG 958ILE  IPEG Image "7 seivn
= Videos ~ labukaprg BS6E KB PNG Image 17 4000 = $000 pinia
& Tash " KonjJPG 95BTLB  IPEG Image nar AR 1 e

. i dord % ; i
Shovem I Nepotrebai_balonipng ISTERE  PNGImage 17
* Paajpg 15MB  IPEG Image A7
Podsd (D)  Plarinajpg 16MB  IPEG Image 117
 PlicalPG 41068  JPEG Image a7
+ Other Locations Prica_u letu joog ISMB  IPEG Image nar
* Rezoluciajpg 1IMB  JPEG image 17
Slojeviisct 165768 xel Hletype "
" Sumajpg 19M8 IPEG Image "7
= Zwoteajpg SITALE  IPEG Image 1ar
* Zubijpg I65EE  IPEG Image A7

Show All Fles

» Select Fie Type (Automatically Detected)

Help Open Cancel

Nakon toga prikazuje se odabrana fotografija ili slika u srediSnjem,
radnom prostoru.

Zanimljivosti i napomene

Odabranu sliku moguce je
otvoriti i dvostrukim
pritiskom lijeve tipke miSa
na sliku. Mogucée je i
oznaditi viSe slika odjednom
i sve ih otvoriti istovremeno
pritiskom na dugme Open.
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Zanimljivosti i napomene

Priblizavanje ili udaljavanje,
bilo koriStenjem povecala
koje se nalazi u alatima s
lijeve strane ili upisivanjem
postotka na dnu programa,
ne utjee na veliinu slike.
To je samo prikaz slike na
ekranu.

¢ [

" 05 pe = | 20w | = esinen 2t e [ - @

U programu GIMP moguce je istovremeno otvoriti viSe slika pa se one
nakon otvaranja nalaze svaka u svojoj kartici, kako je i oznaceno
crvenim okvirom na dolje prikazanoj slici. Odabrana kartica razlikuje se
od ostalih po tome $to je izbo&ena kao drugi po redu na dolje prikazanoj
slici.

< [Baloni] (imported)-3.0 (RGB color 8-bit non-linear integer, GIMP built-in sRGB, 1 layer) 4000x6000 — GIMP

File Edit Select View Image_Llayer Colors Tools Filters Windows Help

o=@ S0 ok

o
& o L T ® . 2000, v i v 00D,
WA EABY -

Slika, tj. kartica koja je oznaCena, moze se zatvoriti pritiskom na dugme
X pokraj svake kartice ili preko izbornika File > Close View.

Ako se Zele zatvoriti sve kartice odjednom, a i dalje ostati u programu
GIMP, odabere se naredba File > Close all.

1.3. Pregled informacija o slici

Kada je slika otvorena u GIMP-u, velik broj informacija o samoj slici
prikazuje se u zaglavlju programa, bez potrebe za odabirom neke
posebne naredbe. Informacije koje se odmah nude su:

1. Naziv otvorene slike nalazi se odmah na poc€etku naslovne
trake. U ovom sluCaju naziv slike je Buket.

2. Odmah pored naziva slike nalazi se tzv. Color Mode, koiji je u
ovom slu¢aju RGB.

3. Takoder, jedna korisna informacija je i broj slojeva na slici. Slika
Buket ima 1 sloj.
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4. Dimenzija otvorene slike nalazi se na posljednjem mjestu. Slika
Buket je dimenzije 2592 x 1944 piksela.

° 12 |°°

o [su#eu (imported)-5.0 (RGB coldf 8-bit non-finear nteger, GIMP builin sl\GB‘h ayer) 2592x1944 -,GIMP

File Edit Select View Image layer Colors Tools Filters Windows Help

e A

VO e s bsoa s (10000 gy [R50, 18000 [1Tsey L T2000,

R T
“OEB -
TENEG D
BN M

e

e P RE,
sSeFaAIN

T

?!
‘3
"
i

[Tool Toggle (Shift)
O Pick a layer or guide
Move the selected layers | —

Mmoo SO

Sy
I

e .

Osim tih osnovnih informacija o slici koje su odmah dostupne i vidljive,
program GIMP nudi i dodatna svojstva o otvorengj slici koja se nalaze
na izborniku Image - Image Properties.

U tom izborniku vidi se kolika je

maksimalna dimenzija slike, ako 4 Image Properties X
se ona ispisuje (Print size). @ Image Properties P
. e . .. [Buket] (i d)-5
Takoder je vidljiva i rezolucija e e _
i ) L. Properties  Color Profile ~ Comment
slike (Resolution), koja je u ovom |——

v . . P Size in pixels: 2592 x 1944 pixels
Slucaju 300 _X 300 ppl Mlnlmalna Print size: 219,46 x 164,59 millimeters
rezolucija slike za tisak je 300 Resolution: 300 x 300 ppi
pp| Korisne informacije su j0§ Color space: RGB color: GIMP built-in sRGB
informacije o veli€ini (File Size) i Precision &-bit non-linear integer
formatu slike (Flle Type) File Name: C\Users\dstipi...mjeri\Buket.jpg

: File Size: 352,4 kB
Dodatan izbornik Image File Type: JPEG image
Properties zatvara se pritiskom Size in memory: 47,0 MB
d CI Undo steps: None
na dugme ose. Redo steps: None
Number of pixels: 5038848
Number of layers: 1
Number of channels: 0
Number of paths: 0
Help Close
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1.4. Uporaba zumiranja, ravnala i pomi€ne linije

U ovom poglavlju obrazlozit ¢e se E¢emu sluzi zumiranje u programu,
kako se koristi te ¢e se navesti tipkovni pre€aci koji se mogu koristiti.
Pojasnit ¢e se i uporaba ravnala i pomic¢ne linije koje se koriste za to¢no
poravhavanje elemenata po dokumentu.

1.4.1. Zumiranje

Kada se slika otvara u programu GIMP, prikaz se podeSava tako da
slika stane u slobodan prostor u radnom prozoru. Prilikom rada na slici,
Cesto je potrebno zumirati i vidjeti izgled slike, fotografije na 100 % ili
vide, a takoder je potrebno i vidjeti kompletnu sliku na ekranu, za sto se
potrebno udaljiti od originalne veli€ine.

Neki od nacina za udaljavanje i priblizavanje slike su:
1. Uporaba alata za zumiranje koji se nalazi u Toolboxu.

2. Odabir dugmeta za prilagodbu slike veli€ini prozora — nalazi se u
gornjem desnom kutu radnog prozora. Tipkovni pre€ac za
uporabu ove naredbe je [Shift]+[Ctrl]+J.

3. Odabir ili upis Zeljenog postotka zumiranja s padajuéeg izbornika
na dnu radnog prozora te potvrda tipkom [Enter].

° @ srce
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Jos jedan nacin zumiranja slike je pritisak miSem na sliku u radnom
prostoru, nakon ¢ega se pritisne i drzi tipka [Ctrl] te se kotaCicem miSa
priblizava ili udaljava slika.

Najlak8i nagin za zumiranje slike je odabir brojeva na tipkovnici:
1 =100 %, 2 = 200 %, 3 =300 %, itd. Osim tih pre€aca, korisne su jo$ i
tipke [+] za priblizavanje i [-] za udaljavanje.

Zumirati se moze i preko izbornika View > Zoom.

1.4.2. Ravnala

Ravnala su korisna za:
e odredivanje to¢ne lokacije miSa na slici
e kreiranje pomic¢nih linija prema odredenoj lokaciji miSa na ravnalu
e kreiranje Sample Pointsa koji se stvaraju tako da se drzi
pritisnuta tipka [Ctrl]] i pomi€u pomi¢ne linije.

Ravnala se prikazuju samo kada se otvori neka slika ili kada se stvori
nova slika, tj. samo kada se nesto nalazi u radnom prozoru. Smjestena
Su na gornjoj i na lijevoj strani slike u radnom prozoru.

< [Buket] (imported)-5.0 (RGB color 8-bit non-linear integer, GIMP built-in sSRGB, 1 layer) 2592x1944 — GIMP

File Edit Select View Image Layer Colors Tools Filters Windows Help

e A

T

g e y A

. o @“@"EE@— i v RSB0 00 7RO 1900,
EaBWERSER

IE,‘/.!!L%.EDO;‘ ,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,
e 4 we ool

A/ AR -

L ]

e 9 & o

Zoom %7_

| Auto-resize window -

Ravnala se mogu prikazati ili sakriti na izborniku View - Show Rulers
ili pomocu tipkovnog pre€aca [Shift]+[Ctrl]+[R].

U podnozju dokumenta moze se promijeniti mjerna jedinica za prikaz
ravnala te vidjeti joS neke dodatne informacije:

1. Dva broja odvojena zarezom prikazuju koordinate miSa na
otvorenoj slici. Gorniji lijevi kut slike su koordinate ,,0, 0“ dok su
donji desni kut koordinate ukupne veli€ine slike. Kako se pomice
mi$ po slici, tako se i mijenjaju brojevi te se moze iScCitati toCna
koordinata. Jedinica u kojoj se prikazuju koordinate jednaka je
jedinici u kojoj se prikazuje ravnalo.

2. Zadana vrijednost ravnala je u pikselima (skrac¢enica ,px“), a ako
se Zeli prikaz ravnala promijeniti u neku drugu jedinicu, odabere
se padajuci izbornik i iz njega Zeljena jedinica.

@ srce .
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3. Osim u zaglavlju, ime otvorene slike nalazi se i u radnom
prozoru, dok se u zagradi pokraj imena nalazi informacija o tome
koliko sistemske memorije ta slika zauzima.

s [Buket] fimported)-5.0 [RGB color B-bit non-linear integer, GIMP buik-in sRGB, 1 layer) 2597x1944 - GIMP.

File Edit Select View Image Layer Colors Tools Filters Windows Help

El

En‘ﬂ‘ oo IR leR e 0 (0 B0 hsee TR0 e RS0 2500
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1 B ® @  |s60d px v | 50% v Buketjpg (47,0 MB) @

06 6

1.4.3. Pomiéne linije

Pomicne linije ili Guides su linije koje se mogu pomicati i postaviti
vodoravno ili okomito preko otvorene slike u radnom prozoru. Sluze za
to¢no poravnavanje objekata na slici.

Pomicna linija postavlja se tako da se miSem dode do ravnala, bilo
okomitog ili vodoravnog, pritisne i drzi lijeva tipka miSa te se miSem
pomice na Zeljenu poziciju. Nakon uspjesno izvedene akcije, prikazat ¢e
se linija na slici u radnom prozoru. Linija se moze i dalje pomicati kada je
u radnom prostoru, a kada vie nije potrebna, odabere se alat Move
Tool (koji se nalazi na izborniku Tools > Transform Tools - Move) i
miSem se odvuce natrag na ravnalo.

Pomiéne linije su plave isprekidane linije, dok je oznadena pomicna linija
prikazana crvenom bojom, kako je oznaceno crvenim okvirom dolje na
slici.

«4d *[Buket] (imported)-5.0 (RGB color 8-bit non-linear integer, GIMP built-in sRGB, 1 layer) 2

File Edit Select View Image Layer Colors Tools Filters Windows Help

=
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Osim dodavanja pomicnih linija miSem, moguce je i preko izbornika

pozicionirati pomi¢nu liniju na tocno odredeno mjesto na slici, vodoravno
ili okomito. Odabere se naredba na izborniku Image > Guides > New

Guide. U novootvorenom sko&nom prozoru odabere se smijer,

vodoravan ili okomit te vrijednost na koju se Zeli postaviti pomi¢na linija.

Nakon odabira, pritisne se dugme OK.

U izborniku Image - Guides moze se jo$ dodati pomi¢na linija po
postotku, moze se postaviti ovisno od selekcije i mogu se obrisati sve
pomic¢ne linije od jednom odabirom naredbe Remove All Guides u
izborniku Image - Guides.

“ New Guide X
Direction Horizontal >
Position 160 - + |

Save Settings

Help oK Reset v Cancel

Zanimljivosti i napomene

Skocni prozor New Guide
obiéno se otvara u pozadini,
tj. iza glavnog prozora
programa pa ga je potrebno
odabrati s programske
trake.
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1.5. Vjezba: Upoznavanje radnog prostora

1. Stvorite novu sliku dimenzije 1000 x 700 px, 300 ppi X i Y rezolucije,
prozirne pozadine.

2. Spremite sliku pod nazivom Prozirna_pozadina.xcf sa svim
ponudenim opcijama.

3. Stvorite novu sliku dimenzije 700 x 800 px, 150 ppi X i Y rezolucije,
bijele pozadine.

4. Novootvorenu sliku bijele pozadine zumirajte na 70 %.

5. Postavite pomi€ne linije na 200 px i 400 px vodoravno.

6. Postavite okomite pomicne linije na 70 % i 80 % slike.

7. Provjerite komentar na slici i koliko slika ima ukupno piksela.
Ukupan broj piksela:

8. Zatvorite sliku Prozirna_pozadina.xcf.

14
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2. Rac¢unalna grafika

Po zavrsetku ovog poglavija polaznik ¢e moci:

e navesti najvaznije formate slika i objasniti njihove razlike
e definirati pojam rezolucije
e podesiti rezoluciju slike

e jzabrati odgovarajucu rezoluciju slike za objavu na web-
Stranicama i za tiskanje

e jzvestii spremiti gotov uradak.

Digitalne slike pojavljuju se u reklamama, novinama, na Internetu,
televiziji i dr. Relativno niska cijena digitalne slike potaknula je mnoge
ljude da istrazuju svoju kreativnost kroz razne programe za obradu slika.
GIMP nudi moguc¢nost odabira veli€ine slike, oblika, kontrolu ekspozicije,
omogucuje dodavanje teksta, slike na sliku, dijelove slika na neku sliku i
drugo. To se naziva obrada rasterske grafike jer je slika na zaslonu
sacinjena od niza tockica rasporedenih u kvadratnu mrezu, a te toc¢kice
nazivaju se pikselima. Kvadratna mreza naziva se raster pa od tuda
naziv rasterska grafika.

Osim rasterske grafike postoji i vektorska grafika kod koje se za opis
slike upotrebljavaju matemati¢ke formule, tj. uz pomoc¢ Bézierove krivulje
i geometrijskih oblika stvaraju se slike. Tako se primjerice za nacrtanu
neku duZinu upotrebljavaju koordinate njezinih krajnjih toCaka pa je ta
duzina odredena kao skup koordinata i linija, a upravo to Cuva kvalitetu
slike pri promjeni veli€ine. Tako je vektorsku grafiku moguce povecavati i
smanjivati bez gubitka kvalitete, a to je Cini idealnom za logotipe,
geografske karte i druge objekte kojima je Eesto potrebno mijenjati
veli€inu. Upravo zbog takvog, ,matematickog“ na€ina pohranjivanja
informacija o slici, vektorska grafika zauzima bitno manje prostora od
rasterske grafike.

2.1. Znacajke pojedinog formata za slike

Odabir pravilnog formata slike jako je vazan jer se na taj nacin osigurava
ispravan prikaz slike u najboljoj mogucoj kvaliteti. GIMP radi s velikim
brojem razliitih slikovnih formata, a za pocetnike je najbolje spremati
slike u XCF formatu, koji je ujedno i GIMP-ov izvorni format. Ako se Zeli
slika prikazati u nekom drugom formatu, vidljivom na ostalim racunalima,
moze s izvesti u neki od poznatih formata kao sto su JPG, PNG, TIFF...

@ srce .
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Format JPG

Skracéenica JPEG (JPG) je kratica engl. Joint Photographic Experts
Group, §to je naziv udruge koja je donijela normu za taj format zapisa.

Format koristi sazimanje podataka uz gubitak kvalitete slike. Moze
sadrzavati slike koje imaju od 2 do 16 milijuna boja (ili nijansi sive boje).
Prvenstveno se koristi za pohranjivanje fotografija, riede za
pohranjivanje crteza ili slika s relativno malo boja.

Najveca prednost formata u odnosu na druge formate je u bitno manjem
zauzecu memorije.

Nedostatak ovog formata su dosta izrazene nepravilnosti slike, posebno
rubne nepravilnosti i Sum, koje se na Stetu ostrine slike tj. bogatstva
nijansi i finih detalja mogu umanijiti zamucivanjem ili primjenom raznih
filtara.

JPG je vrlo popularan format i koristi se za spremanje slika u vecini
fotoaparata, mobitela, tableta i drugih uredaja.

Preporuca se izrada kopija JPG slike prije poCetka obrade u programu
jer se svakim spremanjem slike gubi na kvaliteti slike i taj gubitak je
trajan.

Format JPG prikladan je za koriStenje na Internetu jer ima moguénost
znatnog smanjivanja veli€ine slike, a manje slike Cine web-stranice
brzima za ucitavanje.

To je format koji ne podrzava prozirnost i animaciju, ali je prikladan za
arhiviranje.

Format GIF

GIF (engl. Graphic Interchange Format) je 8-bitni graficki format koji
koristi paletu od maksimalno 256 boja te se zbog toga najcesc¢e koristi
na webu. Pretvaranjem izvornih bitmapa (BMP, JPG, TIFF, PNG idr.) u
GIF drasti¢no se smanjuje broj nijansi kojima se interpretira sadrzaj, sto
rezultira stepenicastim prijelazima pri pretapanju boja i gubitkom finijih
detalja, a najéesce i prejakim kontrastom boja.

Iz navedenih razloga GIF je prikladniji za razne dijagrame i slicne
grafiCke sadrzaje nego za fotografije.

Format PNG

PNG (engl. Portable Network Graphics) je otvoreni graficki format
namijenjen pohrani ili streamingu nepokretnih slika bez gubitaka, a
nastao je kao zamjena za GIF.

Sazimanje podataka bez gubitaka naziv je za proces uklanjanja zalihosti
bez gubitaka informacija. Za razliku od sazimanja podataka s gubitcima,

kod postupka saZimanja bez gubitaka dobiva se slika €iji je prikaz
jednako vrijedan izvornom.

* @ srce
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To znaci da su postupci koji spadaju u ovu kategoriju reverzibilni,
odnosno svakome pripada odreden obratan postupak, koji iz saZete
poruke moZe ponovno stvoriti izvornu.

PNG format je zamisljen kao grafi¢ki format za razmjenu preko
Interneta, tako da ne koristi neke druge sheme boja (kao sto je CMYK).

PNG datoteke u pravilu uvijek imaju ekstenziju PNG ili png.

Format PSD

GIMP moze otvarati i spremati izvornu datoteku programa Photoshop —
PSD (Photoshop document). U GIMP-u je mogucée uredivati svaki sloj
posebno, spremiti datoteku kao PSD i nakon toga je otvoriti u
Photoshopu.

Datoteke PSD otvorene u GIMP-u koje imaju posebna podeSavanja po
slojevima napravljena u Photoshopu, neée se dobro prikazivati u
GIMP-u.

Datoteke PSD koje su izradene u GIMP-u mogu se bez ikakvih
problema otvoriti i uredivati u Photoshopu.

Format RAW

Format RAW je format zapisa slikovnih datoteka u kojemu nema gubitka
informacija, odnosno, to je izvorni oblik slikovne datoteke dobiven
snimanjem nekog motiva. RAW zapis sadrzi sve informacije koje
prilikom fotografiranja aparat zabiljezi bez ikakvih obrada odnosno
kompresije. Slikovna datoteka u RAW formatu sadrzi minimalno
obradene podatke iz senzora digitalnog fotoaparata, skenera ili film
skenera.

RAW format pokazao se kao idealan format u odnosu na druge formate
jer pruza mogucnost da se proces generiranja fotografije u potpunosti
preseli iz fotoaparata na raCunalo. S druge strane, s obzirom na
koli¢inu informacija koje sprema, RAW zapis je znatno veci od ostalih
formata, ¢ak i do nekoliko desetaka megabaijta, Sto ga €ini nezgodnim za
spremanije, slanje i sli¢no.

Jednom kad se datoteka RAW otvori u GIMP-u, ne mozZe se ponovno
spremiti u formatu RAW, nego se moZe izvesti kao JPG ako je potrebna
slabija kvaliteta ili TIFF, ako se slika priprema za ispis.

Format TIFF

TIFF (Tagged Image File Format) je format za pohranu slikovnih
datoteka, iznimno popularan format medu grafiCarima, izdavackoj
industriji te amaterskim i profesionalnim fotografima. Format je objavljen
1986., a od 2009. godine njime upravlja tvrtka ,Adobe Systems*.

Zanimljivosti i napomene

U GIMP-u se za korisnike
Mac raéunala RAW
datoteke otvaraju s veé
unaprijed instaliranim
UFRaw dodatkom, dok ¢e
korisnici Windowsa morati
instalirati dodatak za GIMP
pod nazivom UFRaw ili
pretvoriti Raw datoteku u
TIFF.
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Zanimljivosti i napomene

Za pocCetnike se
preporucuje spremanije slika
u XCF format tako da se
kasnije, prilikom ponovnog
otvaranja, mogu vidjeti svi
podaci o slici.

Format TIFF je Siroko podrzan u aplikacijama za obradivanje fotografija,
izgleda stranice, skeniranje, faksiranje, obradu teksta, optickih znakova
za prepoznavanje i drugih aplikacija.

Format podrzava sazimanje podataka bez gubitaka, ali moze
pohranjivati i nesazete podatke. MozZe sadrzavati slike koje imaju od 2
do 16777216 boja (ili nijansi sive boje). Samo neki (poluprofesionalni i
profesionalni) fotoaparati mogu snimati direktno u TIFF-u, ali vrijeme
spremanija slike na memorijsku karticu aparata moze se produziti na
desetak sekundi pa i do pola minute.

TIFF je memorijski vrlo zahtjevan slikovni format za profesionalnu
uporabu, postere, izlozbene i Jumbo plakate, tehnicke fotografije s
najfinijim razlaganjem detalja. Odlikuje se manje izrazenim
nepravilnostima slike, koristi se za sve namjene, od pohrane crteza i
jednostavnijih slika, do fotografija gdje izvrsno ocrtava sitne detalje.

Prednost opisanog formata u odnosu na format JPEG je kvaliteta slike.

Format XCF

XCF je GIMP-ov izvorni format. U taj format se spremaju svi podaci koji
su napravljeni na slici kao $to su slojevi, putanje, prozirnost i drugo.
Preporuca se koristenje ovog formata kada se slika ureduje u vise
navrata.

XFC format koristi samo GIMP, no kada se zavrsi s uredivanjem slike,
zavrsni korak je izvoz slike u neki drugi format. RjeSenje za to je
spremanje slika u viSe faza tijekom uredivanja tako da se kasnije moze
vratiti na neku od tih faza ako je potrebno.

2.2. Rezolucija slike

Rezolucija kod digitalne fotografije i grafike je ukupni broj piksela nekog
uredaja ili medija (fotoaparata, monitora, fotografije...) kao i broj piksela
po jedinici povrdine. Broj piksela po jedinici povrSine izraZzava se
“pikselima po in¢u” ili PPI (engl. pixels per inch).

DPI je skracenica od dots per inch (engl.), tj. “broj to€aka po in¢u” i
odnosi se na broj to¢aka po in¢u kod ispisnih uredaja. Da bi se dobila
neka boja, pisa¢ mijesa tinte razlicite boje i za jedan piksel mora ispisati
odredeni broj toCkica. Broj to¢kica ovisi o razlu€ivosti pisaca.

Vedi broj DPI-a ne moze povecati PPI. PPl se odnosi na raspolozive
piksele po in€u koji grade fotografiju, a DPI na to koliko ¢e tockica tinte
pisac ispisati da bi ispisao piksele na jednom in¢u papirne plohe. Manji
broj DPI-a moze zamaskirati nedostatak PPI.
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Vide ukupnih piksela na nekoj slici znacgi vecu rezoluciju slike i samim
time kvalitetniju sliku, a manje piksela manju rezoluciju tj. loSiju sliku.
Kada se ureduje neka slika u GIMP-u, ureduju se zapravo pikseli na toj
slici. Piksel je najmaniji graficki element neke slike koji u sebi sprema
varijaciju svjetline i boje.

™ 5 U programu GIMP rezolucija slike provjerava se
= preko izbornika Image - Image Properties.

2.3. Priprema slike za tisak i web

Priprema slika za web i tisak razlikuje se prvenstveno u kvaliteti same
slike, 8to podrazumijeva rezoluciju slike, broj to¢aka po in€u i modelu
boja. Za tisak je potrebno imati sliku viSe kvalitete u CMYK modelu boja,
dok je za web dovoljna i slika slabije kvalitete u RGB modelu boja.

RGB je skracenica za engleski pojam Red (crvena), Green (zelena),
Blue (plava). RGB je aditivni model boja kod kojeg se sabiranjem
oshovnih boja dobije bijela boja. Jedna boja opisuje se kroz tri
vrijednosti: dio crvene, dio zelene i dio plave boje. Svaki dio boje varira
izmedu 0 % i 100 %, odnosno izmedu 0 i 255.

CMYK je suptraktivan model mijeSanja boja koji se primarno koristi u
tiskarstvu. Skrac¢enica je oznaka boja u engleskom jeziku: cyan (cijan,
tirkizna), magenta (purpurna), yellow, (zuta) i key (crna). lako se
kombinacijom prve tri boje teoretski dobije crna boja, u tiskarstvu se crna
koristi kao zasebna (Cetvrta) boja, radi bolje reprodukcije tamnih boja.

2.3.1. Slike za tisak

Preporu€ena rezolucija slika koridtenih u pripremi za tisak je 300 ppi za
fotografije i 600 ppi za jednobojne ilustracije. Ako se kompletna priprema
radi kao bitmapa (npr. u GIMP-u) potrebno je prije poCetka rada na
pripremi odrediti $to viSu rezoluciju (barem 300 ppi, preporuka 600 ppi
ako priprema ukljucuje vecu koli€inu teksta ili tekst manji od 12 to¢aka).

Sve boje koriStene u pripremi za tisak moraju biti u CMYK-u (fontovi,
slike i vektorski elementi). Boje u dokumentu koje nisu CMYK nego
RGB, bit ¢e konvertirane u CMYK, prilikom ¢ega su moguci manji ili vedi
odmaci u vjernosti reprodukcije boja.

Kada se smanjuje rezolucija slike, treba uzeti u obzir da smanjivanje
rezolucije slike povecéava Sirinu i visinu slike, dok povecavanje rezolucije
slike smanijuje Sirinu i visinu slike. To je bitno zapamtiti jer se prilikom
promijene rezolucije slike mijenja samo broj piksela koji ¢e se prikazivati
po in¢u doti¢ne slike, a ne koliko piksela €ini tu sliku.
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Za promjenu rezolucije slike odabere se Image - Print Size... U
sko¢nom prozoru Set Image Print Resolution moze se mijenjati
rezolucija slike.

4 Set Image Print Resolution X
& Set Image Print Resolution Ex
[Buket] (imported)-2
Print Size
width: (B - +|
Height: 164,59 - + | mm~
X resolution: 300,000 -+ 1
Y resolution; 300,000 — + pixels/in ¥
Help Reset oK Cancel

Sliku je najbolje snimiti u TIFF formatu, ali moze se odabrati i JPG
format, no tada je potrebno odabrati visoku kvalitetu (u GIMP-u pod
Quality: 90-High ili 100-Maximum).

2.3.2. Slike za web

Slike za web ne trebaju biti vrhunske kvalitete poput slika za tisak pa je
naj¢esca radnja koja se koristi u GIMP-u za prikazivanje slika na webu,
smanjivanje slike na zadovoljavajucu rezoluciju.

Za promjenu rezolucije slike odabere se na izborniku Image naredba
Scale Image. Kao duljinu najdulje stranice preporuca se unijeti 700 px.
To je standardna veli€ina slike za web s obzirom na to da je normalno
vidljiva na ekranu rezolucije 1024 x 768. Nakon unesenih vrijednosti
potrebno je kliknuti na dugme Scale.

¥ Scale Image X

=_Scale Image B

[Buket] (imported)-2
Image Size

Width: 700 - +

BE -

Height: 525 -+
700 x 525 pixels
X resolution: 72,000 - +

—_
o
-
4

pixels/in  ~

— =5

Y resolution: | 72,000 -+

Quality

Interpolation:  Cubic v

Help Reset Scale Cancel
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U nazivima slika ne preporuca se koristiti dijakriticke znakove, ve¢ samo
slova engleske abecede. Takoder, u nazivima se ne preporucuju
razmaci, a ako se naziv slike sastoji od viSe rije€i, povezuje ih se crticom
ili donjom crticom. Nazivi slika mogu sadrzavati velika i mala slova.

2.4. lzvoz i spremanje slika

Nekako je intuitivho da se kod spremanja slike u neki odredeni format
odabere naredba iz izbornika File > Save ili File > Save As..., aliu
grafickim alatima kao $to je GIMP, naredbe Save ili Save As... koriste
se za spremanje u GIMP-ov izvorni format XCF. Nakon §to se odabere
jedna od tih naredaba, upiSe se Zeljeni naziv slike te se pritisne na

dugme Save.
Ako se Zeli spremiti slika u nekom drugom formatu, kao $to je JPG, Zanimljivosti i napomene
TIFF, PNG, PSD, GIF PDF, BMP ili neki drugi, potrebno je to uciniti Sliku spremljenu u XCF
preko izbornika File > Export As. format moguce je otvoriti na
drugom ra¢unalu samo ako
U prozoru Export Image potrebno je upisati naziv slike koja ¢e se i to drugo radunalo ima
spremiti, odabrati mjesto spremanja i format. instaliran program GIMP.
Ako se slika Zeli otvoriti na
Naziv slike upisuje se u polje Name na vrhu izbornika, oznaeno drugom racunalu, potrebno
crvenim okvirom na donjoj slici. Ju je izvesti u neki drugi
standardni format.

U sredini izbornika odabire se mjesto spremanja slike. Nakon odabira
zeljenog mjesta, moguce je i izraditi novu mapu pritiskom na dugme
Create Folder.

Na kraju se odabire format u koji ¢e se slika spremiti. Moguce je upisati
direktno format pokraj naziva slike (koji se piSe u obliku
Ime_slike.format_slike) ili pritisnuti na oznaku + koja se nalazi pored
teksta Select File Type (By Extension) za prikaz svih ponudenih formata.
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& Export Image X

Name: I Buket.png I

% Home < | S danst ® Desktop @ Polaznik > =

& Desktop Name ~ | Size Type Modified Preview

Downloads

)

o

Music

&

Pictures
Pictures

Folder

&1

Videos

_ Local Disk (C)

Show All Files
~ Select File Type (PNG image)
File Type Extensions
PGM image pgm
Photoshop image psd
PNM image pnm
Portable Document Format pdf
Help Export Cancel

Svi ponudeni formati mogu se pregledati pomocu klizaca na desnoj
strani te pritiskom na Zeljeni i odabrati. Nakon odabira pritisne se na
dugme Export. Na gornjoj slici odabran je format PNG u dodatnom
otvorenom izborniku za izbor formata slike i ozna¢en crvenim okvirom.

Ponekad je potrebno smanijiti veli¢inu JPG slike na Stetu kvalitete slike.
Kada se na izborniku Export Image odabere format JPG i pritisne na
dugme Export, pojavi se prozor Export Image as JPEG u kojem je
pomocu klizaca, prikazanog crvenim okvirom na donjoj slici, moguce
povecavati ili smanjivati kvalitetu slike od 0 do 100, a samim time i
konacénu veli€inu slike na racunalu. Pravilo je da §to je veca kvaliteta
slike, slika zauzima viSe prostora, a §to je manja kvaliteta, slika zauzima
i manje prostora na racunalu.

| vt Export Image as PNG X
Pixel format | Automatic v

Interlacing (Adam7)

| Metadata [edit

Save Exif Save IPTC Save XMP
Save color profile Save thumbnail
Save background color Save layer offset Save resolution

Save creation time

Save comment |

CREATOR: gd-jpeg v1.0 (using )G JPEG v80), default quality

| | Load Saved Settings Save Settings

Help Export Reset v Cancel
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2.5. Korisne napomene za pocetnike

Prije poCetka rada na uredivanju slike u GIMP-u, preporucljivo je izraditi
kopiju originalne slike.

Ako se ne izradi kopija originalne slike, moze se dogoditi sljedece:

- ako se napravi neka greSka na slici, unistit ¢e se jedina kopija
te slike

- ako se slika umaniji za prikaz na web-stanici, moze se dogoditi
da nam ostane samo primjerak koji je neupotrebljiv za tisak
zbog veli¢ine i kvalitete

- viSekratnim otvaranjem, uredivanjem i spremanjem slike u JPG
formatu smanijuje se razina kvalitete JPG slike pa je zato uvijek
dobro raditi s TIF ili XCF datotekom.

Prostor na disku je relativno jeftin u usporedbi s vra¢anjem na mjesto
fotografiranja i ponovnim fotografiranjem istog prizora.

Spremanije slika po fazama izrade moze biti korisno, kako bi se mogli
vratiti na neki od prethodnih koraka u obradi slike.
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3. Osnovni alati za rad s grafikom

Po zavrsetku ovog poglavija polaznik ¢ce moci:

e objasniti ulogu slojeva u obradi slika
e dodati, ukloniti i duplicirati sloj te podesiti prozirnost sloja
e upotrijebiti razlicite alate za oznacCavanje dijelova slike

e obrezati sliku, promijeniti joj veli¢inu, rotirati je, zrcaliti,
pomaknuti ili skalirati

e upotrijebiti alate za crtanje

e podesiti boje na slici.

Za uspjesno bavljenje obradom grafike u GIMP-u te obavljanje radnji
poput uklanjanja nepotrebnih dijelova, crtanja novih dijelova, rotiranja
slike, izrezivanja, povecavanja i smanjivanja, potrebno je dobro
poznavati osnovne alate.

3.1. Uporaba slojeva i alata za oznac¢avanje

Za obradu bilo kakve grafike, jednostavnije ili slozene, nuzno je shvatiti
¢emu sluze slojevi i kako se koriste. Jednako tako, upoznavanje s
alatima kojima se oznacava neki dio slike da bi se kasnije s oznaenim
djelom nesto radilo, vazno je kako za pocetnike, tako i za naprednije
korisnike.

3.1.1. Slojevi

Slojevi (engl. layers) sluze za spajanje dvije ili vise slika u jednu. Slojevi
su neke zasebne slike poredane jedna iznad druge, a mogu biti prozirni
tako da se vidi cijela ili samo neki dio slike ispod ili iznad toga sloja.

@ srce .
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Zanimljivosti i napomene

Dobra je praksa svakom
sloju promijeniti naziv radi
lakSeg snalazenja u kasnijoj
fazi obrade slike kada ima
puno slojeva na jednoj slici.

Na primjeru crteza kuéice moze se vidjeti da su oblik kucice, prozori i
vrata zasebne slike, svaka u svojem sloju. Kada se spoje pravilnim
redoslijedom, dobiva se kompletna kucica. Pravilan redoslijed znaci da
¢e se u zadnjem sloju nalaziti oblik kuce, na sloju iznad prozori te u
prvom sloju vrata. Kada se koriste slojevi, vrlo lako moZe doci do
izmjena slike u bilo kojem segmentu te slike, bez utjecaja na neke druge
dijelove na slici, jer se radi samo na tom odredenom sloju.

Dodavanje novog praznog sloja

Za dodavanje novog praznog sloja na otvorenoj slici potrebno je odabrati
naredbu New Layer... iz izbornika Layer.

<l New Layer X
= Create a New Layer
Slojevixcf-3 =

Layer name: | | Switches
Color tag: ® [ | = @ Visible

A I Lock pixels
Mode: Normal (1) v v

% [ Lock position and size
fl e ® | Lock visibility
Composite space: a | ILock alpha

Composite mode:

Opacity: 1000 -

Width: 800 -+
Height: 600 - +|px ¥
Offset X: 0 -+
Offset Y: 0 - + px -
Fill with: Transparency v
Help OK Cancel

Pojavljuje se skoCni prozor New Layer gdje se nudi mogucnost upisa
naziva sloja, promjena veli€ine sloja, odabir ispune sloja i jo$ neke druge
opcije koje nisu u ovom trenutku toliko vazne. Nakon zavrSetka pritisne
se na dugme OK.

Novi sloj pojavljuje se u desnom dijelu programa i oznacen je plavom
bojom. Za promjenu imena sloja odabere se dvostrukim klikom lijeve
tipke miSa sloj i upiSe novo ime.
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Osim dodavanja novog sloja, u izborniku Layer moguce je i obrisati
oznaceni sloj pomo¢u naredbe Delete Layer, duplicirati sloj naredbom
Duplicate Layer te druge manje vazne naredbe za pocetnike.

Sve najceSc¢e koriStene naredbe vezane za slojeve nalaze se i na
odmah dostupnom desnom izborniku u skupini Layers, oznaCene
crvenim okvirom na gornjoj slici.

Kada se koristi viSe slojeva, mnogo puta je potrebno premjestati slojeve
tj. zamijeniti raspored slojeva. To se radi metodom Povuci i ispusti
(engl. Drag&Drop), to jest odabere se i drzi ljevom tipkom misa sloj koji
se zeli premijestiti i premjesti se na Zeljeno mjesto. Osim navedenog
nacina, moguce je oznaditi sloj i pritisnuti miSem na dugme zelenih
strelica za premjestanje tog sloja gore ili dolje. Strelice se nalaze na dnu
brzog desnog izbornika Layers, takoder oznacenog na gornjoj slici.

Na svakom sloju moguce je promijeniti i prozirnost toga sloja, tj. Opacity
u vrijednosti od 0 do 100, gdje je 0 potpuno prozirno, a 100 potpuno
neprozirno. Vrijednost je moguce upisati, pomicati pomocu klizaca ili
promijeniti pomoc¢u okretnog dugmeta. Na gornjoj slici je oznacen
crvenim okvirom sloj Oblak, s Opacity vrijedno3¢u 70.
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3.1.2. Alati za ozna€avanje

Mnogo korisnika ne zna pravilno Koristiti alate za oznacavanje i tako si
otezavaju rad u GIMP-u. Alati za oznaCavanje nalaze se na vrhu
Toolboxa.

GIMP sadrzi sljedece alate za oznaCavanje u Toolboxu s lijeve strane:

1. Rectangle Select — je koristan alat za ozna¢avanje kvadratnih ili
pravokutnih oblika na slici.

2. Ellipse Select — koristi se ako se Zeli oznaciti neki kruzni oblik
na slici.

3. Free Select ili Lasso — omogucuje oznacavanje nekog
nepravilnog objekta tako da se oznacava lijevom tipkom misa
vanjski rub tog objekta pomocu toCaka. Ako se pogrijeSi, moze
se doci iznad toCke koja je krivo postavljena i pomaknuti je na
Zeljenu poziciju. Selekcija se zavrSava odabirom pocetne tocke.

4. Fuzzy Select ili Magic Wand — jako koristan alat koji oznaCava
samo ono podrucje koje je odabrano tim alatom.

5. Color Select — je koristan alat ako se Zeli oznaciti samo dio slike
izraden bojom koja je odabrana tim alatom.

6. Scissors Select — je odlican i jednostavan alat kojim se moze
odabrati neki objekt, ali za odabir je potrebno samo okvirno
kliknuti miSem oko objekta, a Skare ¢e same pronaci rubove. Za
zavrSetak selekcije, potrebno je odabrati pocetnu tocku.

7. Foreground Select — sluzi za ozna€avanje na slici u dva koraka.
Prvi je odabir Zeljenog djela slike, a drugi je dodatna korekcija.

Osim navedenih alata, korisne naredbe za ozna¢avanje nekog dijela
slike nalaze se jo$ i u izborniku Select, Ciji se opis moze pronaéi u
prilogu ovog priru€nika.

Obi¢no je najlakse i najbrze oznaCavati neke pravokutne ili kruzne
oblike, ali ako je potrebno napraviti selekciju na nekom nepravilnom
obliku tu je potrebna domisljatost i dobro poznavanje alata. Ponekad je
lak$e oznacCavati pozadinu objekta te nakon toga samo izokrenuti
selekciju tako da bude oznacen Zeljeni objekt, a nekad je pozadina toliko
razliita da je lakSe oznaciti objekt.
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Jedan jednostavan alat za selekciju nepravilnih oblika je Scissors
Select koji se joS naziva i Intelligent Scissors, ako se do njega pristupa
preko izbornika Tools > Selection Tools. Moze mu se pristupiti i preko
Toolboxa koji se nalazi s lijeve strane programa.

Moguce je u nekoliko koraka oznaditi neki nepravilan oblik:
1. Prvo se otvori sliku u GIMP-u.

2. Da bi se lakSe i toCnije mogao oznaciti zeljeni objekt na slici,
dobro je zumirati taj objekt na minimalno 200 %.

3. Sada je potrebno odabrati alat Scissors Select i oznacavati
pomocu todaka granice objekta koji se Zeli oznagiti. Sto je vedi
broj to€aka, to ¢e biti preciznija konacna selekcija. Selekcija se
zatvara tako da se zatvori krug, tj. odabere se pocetna tocka.
Ako se pogrijesi s nekom to¢kom u selekciji, moguce je zadati
novu toCku te nakon toga odabrati onu koja je na pogreSnom
mjestu i premijestiti je na zeljenu poziciju ili odabrati neki drugi
alat u Toolboxu, pa opet na alat Scissors Select i krenuti iz
pocCetka. Nakon zavrSenog oznaCavanja, objekt bi trebao
izgledati kao na donjoj slici.
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4. Nakon uspjesno oznacenog objekta, pritisne se tipka [Enter] tako
da se vidi oznaCeno podrucje.

5. Ako se Zeli izbrisati konacna selekcija, potrebno je na izborniku
Select odabrati naredbu None.

UspjeSno oznacen objekt mozZe se kopirati, rezati, bojati, premjestati te
se na njemu mogu raditi sve akcije kao na zasebnoj slici.
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Zanimljivosti i napomene

Ako se Zeli dodatno
popraviti oznaka, kada je
objekt oznac¢en odabere se
naredba Quick Mask, koja
se nalazi u donjem lijevom
kutu radnog prostora.
Nakon toga, odabere se
Paintbrush i popravi
oznaka.
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3.2. Alati za transformaciju

Mnogo puta je potrebno obrezati sliku, promijeniti veli€inu, rotirati,
zrcaliti, pomaknuti ili u€initi neke druge transformacije s otvorenom
slikom, a to se postize skupinom alata koji se nalaze u izborniku Tools
- Transform Tools.

Rotiranje slike

Ako se zeli izravnati neka slika ili rotirati, koristi se naredba Rotate:

1.
2.

Otvori se slika u GIMP-u koju je potrebno rotirati.

Za rotiranje slike odabire se naredba Rotate u izborniku Tools
- Transform Tools ili u Toolboxu s lijeve strane.

Kada se odabere bilo koji alat, pa tako i Rotate, pojavljuju se
dolje nize u Toolboxu dodatne opcije za taj alat, naziva Tool
Options. U tim je opcijama potrebno odabrati u padajuéem
izborniku pod Clipping, naredbu Crop to result, koja odmah
obreze sliku.

Pritisne se lijevom tipkom mi$a na sliku gdje se pojavljuje mreza
ispred slike i dodatni sko¢ni izbornik Rotate.
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5. U sko€nom prozoru moguce je pomocu okretnog dugmeta
odabrati za koji kut ¢e se slika okrenuti, lijevo ili desno, moguce
je ru€no upisati vrijednost ili odabrati vrijednost pomocu klizaca.
Nakon odabira pritisne se na dugme Rotate.

sedl *[Pisa] (imported)-2.0 (RGB color 8-bit nan-linear intager, GIMP built-in sRGB, 1 layer) 20003008 - GIMP
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6. Slika je sada ispravno poravnata, ali ima prazan prostor oko
rubova. Najlaksi nacin za brisanje praznog prostora oko slike je
da se na izborniku Image odabere naredba Crop to Content,
kako je i oznaCeno crvenim okvirom na gornjoj slici.

Zrcaljenje slike

Kada se otvori slika koja je okrenuta naopako, vertikalno ili horizontalno,
moguce je vrlo lako sliku vratiti u ispravan polozaj. Postoje dva nacina;
da se slika zrcali preko izbornika ili preko Toolboxa.

Za zrcaljenje slike preko izbornika odabere se Image - Transform. U
tom izborniku moguce je odabrati naredbe Flip Horizontally za
zrcaljenje slike vodoravno, Flip Vertically za zrcaljenje slike okomito te
naredbe za brzo rotiranje slike po 90 stupnjeva.

Slika se moze zrcaliti i preko alata Flip Tool koji se nalazi u Toolboxu.
Nakon odabira alata, odabere se pod dodatnim opcijama alata naredba
Horizontal ili Vertical, ovisno o tome Zeli li se slika zrcaliti vodoravno ili
okomito. Pritiskom na sliku ona se zrcali na odabranu stranu.
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Na sljedeco;j slici crvenim okvirima oznacen je izbornik Transform i
dodatne opcije alata u Toolboxu.
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Obrezivanje slika

Obrezivanjem slika briSu se originalni rubovi ili dijelovi slike. Obrezivanje
slike korisno je kada se Zele obrisati neki dijelovi koji nepotrebno
odvlace paznju na slici, kada se Zeli bolje istaknuti motiv ili se
jednostavno neki dio slike Zeli odrezati. U programu GIMP obrezivanje
se izvodi alatom Crop Tool koji se nalazi u Toolboxu ili na izborniku
Tools - Transform Tools - Crop. Prije obrezivanja poZzeljno je napraviti
kopiju originalne slike za slucaj da se preveliki dio slike odreze.

Postupak obrezivanja slike je vrlo jednostavan:

1.
2.

Prvo je potrebno otvoriti sliku i odabrati alat Crop Tool.

Nakon toga potrebno je oznaditi sliku, a to se radi tako da se
pritisne i drzi lijeva tipka miSa na dijelu slike koji se zeli oznaditi,
zatim se povuce misem dijagonalno preko dijela slike koji se zeli
oznaciti. Oznaceni dio slike ¢e posvijetliti, a ostali dio potamnjeti.
Sav dio koji je potamnio bit ¢e odrezan, a samo ¢e ostati
posvijetljeni dio slike. Kada se oznadi slika, moguce je i korigirati
selekciju tako da se prode miSem iznad bilo kojeg ruba selekcije i
pomocu njega poveca ili smanji ukupna selekcija.

Za konacno obrezivanje slike, potrebno je pritisnuti tipku [Enter].
Primjer obrezivanja prikazan je na sljedeéim slikama.
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Nakon obrezivanja slike i spremanja kao zasebne slike, rezultat je samo
motiv koji se zZelio istaknuti u centru slike.
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Zanimljivosti i napomene

Skaliranje ili promjena
veli¢ine slike je razli€ito od
zumiranja. Kada se slika
priblizava ili udaljava to
samo utjece na vrstu
pogleda na ekranu i ne
utje€e na veli€inu same
slike, dok skaliranje mijenja
trajno sliku na potpuno
drugadiju veli€inu.

Promjena velic¢ine slike

Promjena veli€ine slike tako da bude manja od originalne, obi¢no ne
utjeCe na kvalitetu slike, ali promjena veliCine slike na vise, tj. da slika
bude veca od originalne slike, moze utjecati na kvalitetu slike. Kao i kod
drugih alata, i kod ovoga je dobro napraviti kopiju originalne slike prije
nego se pocne mijenjati veli€ina slike.

Ako se zeli promijeniti veli¢ina neke slike, koristi se alat Scale Tool koji
se nalazi u Toolboxu ili na izborniku Tools - Transform Tools - Scale.
Promjena veli€ine slike moze se primijeniti u gotovo svim standardnim
jedinicama kao $to su pikseli, postotci, in€i, milimetri, centimetri, metri i
drugi.

Primjerice, ako se neka slika Zeli povecati, tj. skalirati za 250 %,
postupak je vrlo jednostavan:

1. Prvo je potrebno otvoriti sliku kojoj se Zeli promijeniti veliCina i
uzeti alat Scale Tool te kliknuti miSem na sliku u radnom
prostoru ili do¢i do naredbe preko izbornika Image - Scale
Image...

2. Pojavit ¢e se skoCni prozor Scale Image gdje se prvo odabire u
kojim jedinicama se zeli promijeniti veliina slike. Za primjer ¢e
se odabrati postoci, tj. znak %. U podrucje Image Size moze se
ruéno upisati ili pomocu okretnog dugmeta odabrati vrijednost na
koju ¢e se slika skalirati u odnosu na originalnu veli¢inu slike. Na
dolje prikazanoj slici, slika se pove¢ava za 250 %, $to je
oznaceno crvenim okvirom.

« Scale Image X
Scale Image
n .
[Bubamara] (imported)-6
Image Size
Width: | 250 — é
Height: 250,00 -+ 7 % -
513 x 360 pixels
X resolution: 180,000 - + é
Y resolution: | 180,000 - + | ; pixels/in
Quality
Interpolation:  Cubic v
Help Reset Scale Cancel

3. Nakon odabira pritisne se dugme Scale.
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Izgled originalne slike prije povecavanja:

Izgled slike nakon

povecavanja za 250 %:

X

Na isti nacin se i smanjuje veliCina slike, samo Sto bi se u ovom slucaju
odabrao maniji broj od 100 %.

Pomicanje objekata

Za pomicanje bilo kakvih objekata, selekcija ili teksta na slici, koristi se
alat Move Tool u Toolboxu, a mozZe se do njega doci i preko izbornika
Tools > Transform Tools > Move. Odabere se alat i klikne se lijevom
tipkom misa na objekt koji se Zeli pomaknuti.

3.3. Alati za crtanje

Svi alati za crtanje nalaze se u izborniku Tools - Paint Tools. Vecina
tih alata koji su namijenjeni bas za crtanje prikladna je i za graficke
tablete, ali moguce ih je koristiti i pomoc¢u misSa. Tako su neki intuitivni
alati za crtanje poput olovke, Pencil Tool u Toolboxu koji sluzZi za crtanje
linija s tvrdim rubovima, Paintbrush koji sluzi za crtanje mekih rubova,

g
Paintbrush

Mode Normal ¥/ &~

[Opadity " 000] -

@ Brush
2. Hardness 050 |

36,00 |=/+/&H
0,00 |—|+/SI[#
0,00 |—|+/SI[#

By 100 |-+ &

L ENSEE

. 0 -+ 2

Enable dynamics

Apply Jitter
Smooth stroke
Lock brush to view
Incremental

Expand Layers

Eraser briSe linije ili dijelove crteza ili slika,
Airbrush sluzi za crtanje jako mekih linija, Ink
sluZi za pisanje ili crtanje kaligrafskim stilom,
Bucket Fill popunjava podrucja s odabranom
bojom, Blend popunjava gradijentnom bojom
odabrana podrugja.

Svaki od tih alata za crtanje sadrzi u dodatnim
opcijama Tool Options, puno parametara koji se
mogu podesiti. Tako se moZe birati veli¢ina, oblik,
kut pod kojim se Zeli crtati, boja, prozirnost te
mnoge druge mogucnosti koje mogu biti jako
korisne.
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Crtanje sa selekcijama

Selekcije, osim Sto sluze za oznaCavanje objekata, mogu se Koristiti i za
crtanje tako da ih se popunjava bojom ili se obrubljuju.

Za popunjavanje selekcija bojom prvo je potrebno odabrati alat za
oznacgavanje i napraviti Zeljeni oblik selekcije. Kada se izradi oblik,
moguce je korigirati taj oblik po svakom rubu selekcije te nakon toga
pritisnuti tipku [Enter] tako da selekcije izgledaju kao na dolje prikazanoj
slici.

Zanimljivosti i napomene

Za dodavanje izvornoj
oznaci dodatnu oznaku,
potrebno je drzati tipku
[Shift] i bilo kojim alatom za
oznacavanje docrtati
oznaku. Za oduzimanje
oznake, potrebno je
pritisnuti tipku [Ctrl].

.

Kada se izradi selekcija, potrebno je samo uzeti alat Bucket Fill,
odabrati boju Foreground u Toolboxu i pritisnuti miSem unutar selekcije.
Selekcija je obojana u boju koja je odabrana na paleti boja, unutar opcije
Foreground.

Osim popunjavanja selekcija bojom, moguce je i bilo kojoj selekciji
dodati rub koji se kasnije boja s Bucket Fillom ili se odmah dodaje rub
obojan u boju Foreground boje. To je jako korisno ako se Zeli oznaditi
neki dio slike okvirom, obrubiti neka slika ili samo njezin dio.
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Za izradu ruba na selekciji krece se od same izrade selekcije, koju je
potrebno podesiti, te nakon to se izradi selekcija klikne se desnom
tipkom miSa na selekciju i iz izbornika Select odabere se naredba
Border.

«d Border Selection X

Border selection by

|10 - +|px v

Border style Smooth ¥

Selected areas continue outside the image

Help OK Cancel

U sko&nom prozoru Border Selection by potrebno je upisati debljinu ruba
u jedinicama koje se mogu birati, na gornjoj slici su to pikseli. Opcija
Selected areas continue outside the image, ako se ukljudi, j. stavi
kvacica, pruza njezan prijelaz boja na rubu. Nakon zavr$etka, pritisne se
na dugme OK.

Na kraju je potrebno uzeti Bucket Fill, odabrati Zeljenu Foreground boju
i pritisnuti unutar ruba da se on oboji.

Osim bojanja nakon dodavanja ruba, moguce je i odmah oboajiti rub bez
upotrebe alata Bucket Fill. Kada se izradi selekcija, pritisne se desnom
tipkom miSa na selekciju i u izborniku Edit odabere se naredba Stroke
Selection... U otvorenom skoénom prozoru Stroke Selection, koji je
prikazan na slici dolje, moze se upisati ili okretnim dugmetom odabrati
debljina ruba pod opcijom Line With:. Boja ruba bit ¢e jednaka boji koja
je odabrana u paleti boja Foreground.

«d Stroke Selection X
i Choose Stroke Style B
Selection Mask-15 ([Untitled])
Line Paint tool

O Foreground color
Background color

Pattern
& Antialiasing
Line width: | 6,0 - + px ¥
Cap style: m @ W
Join style: F &

Miter limit: ‘ 10,0 -+
Dash pattern: < [ 1 - I 1|11+ | >
Dash preset: = Custom —
Help Reset Stroke Cancel
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Nakon odabira debljine, potrebno je pritisnuti lijevom tipkom misa na
dugme Stroke. Dolje na slici prikazano je obrubljivanje pomoc¢u naredbe
Border... i Stroke Selection...

Dupliciranje ili kopiranje dijelova slika

Za dupliciranje dijela slike s iste ili neke druge slike koristi se alat Clone
Tool koji se nalazi u Toolboxu ili na izborniku Tools - Paint Tools >
Clone. Osim za dupliciranje, alat je odli¢an i za popravak ostecene slike
te uklanjanje nepotrebnih dijelova.

Za dupliciranje ili popravljanje slike potrebno je poduzeti sljedece
korake:

1. Otvori se slika te se zumira radi lakSe obrade.

2. Odabere se alat Clone Tool te se prije koriStenja podese
dodatne opcije alata. Bitno je da se podesi pravilna veli€ina alata,
tvrdoc¢a rubova i kakvo ¢e biti poravnanje (Size, Hardness i
Alignment). Veli€ina i tvrdo¢a rubova alata ovise o tome da li se
duplicira veliki dio slike pa je potrebna veéa veli€ina ili se nesto
precizno radi pa je bolje da je veli€ina $to manja. Poravnanje se
moze odabrati s padajuceg izbornika, a ¢esto se koriste None i
Aligned. None uvijek kreCe od pocCetne toCke dok Aligned prati
kretanje ovisno o lokaciji na slici, $to ¢e se bolje razumijeti
prilikom koriStenja toga alata.

3. Clone Tool radi malo drugacije od dosadasnjih alata te ga je
potrebno prvo aktivirati. Aktivira se tako da se pronade na slici
dio koji se Zeli duplicirati ili kopirati te se pritisne na tipku
[Ctrl]+lijeva tipka miSa. To je poCetna to¢ka od koje Ce se poceti
duplicirati ili kopirati taj dio slike.
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4. Nakon toga pomice se alat na podruéje gdje se Zeli postaviti
duplicirani dio i kre€u se raditi linije ili se tapka po tom podrucju
pritiskom na lijevu tipku mi$a. Uvijek se moze pritisnuti na
kombinaciju tipki [Ctrl]+[Z] ako se pogrijeSi te se krece iz poCetka.

Primjerice, pocetna ili originalna slika prikazuje balone koji lete. Ako se
neki baloni zele ukloniti, a neki duplicirati, Clone Tool je odli¢an alat za
takve stvari

Nakon uspjesSnog koriStenja alata Clone Tool, uklonjena su tri balona, a
lijevi balon je dupliciran, to se mozZe vidjeti na donjoj slici.
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Izbjeljivanje ili tamnjenje dijelova slike

Ako se zeli neki dio slike pobijeliti ili potamniti, koristan je alat Dodge /
Burn Tool, koji se nalazi u Toolboxu ili na izborniku Tools - Paint Tools
- Dodge / Burn.

Prvo je potrebno otvoriti sliku koju se zeli obraditi na ovaj nacin.
Odabere se alat Dodge / Burn Tool i kada se Zeli izbijeliti neki dio slike,
u dodatnim opcijama alata u Toolboxu odabere se odgovarajuc¢a veli¢ina
alata, pod opcijom Type odabere se naredba Dodge i pod opcijom
Range naredba Midtones. Exposure moze ostati kako je i po
standardnim postavkama na 50 %.

Na dijelove slike koji se Zele izbijeliti potrebno je samo tapkati alatom i
oni ¢e se izbjeljivati. Moguce je u hodu i smanijivati veli€inu alata, ako je
potrebna veca preciznost, ili povecavati alat, ako se treba izbijeliti neka
vecéa povrsina. Ako se Zeli potamniti, tj. spaliti neki dio slike, potrebno je
u dodatnim opcijama odabrati naredbu Burn i raditi s alatom na isti
nacin kao i kad je bila odabrana naredba Dodge.

Alat moze biti koristan za izbjeljivanje zuba kao Sto je to prikazano na
donijoj slici. Gornji zubi su izbjeljivani, dok su donji zubi spaljivani
pomoc¢u Dodge / Burn alata.
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3.4. Alati za podeSavanje boja

Slike s previse svjetla ili tame, koje nisu ostre, koje su prebogate bojama
ili imaju neki drugi problem s bojama moguce je rijesiti alatima koji se
nalaze u izborniku Colors.

Podesavanje svjetline i kontrasta

Ako se slika Zeli posvijetliti, potamniti ili se Zeli dodati kontrast, koristi se
opcija Brightness-Contrast... koja se nalazi u izborniku Colors, a moze
se koristiti i ako se Zeli pomocu svjetline istaknuti neki objekt na slici.

Za podeSavanje svjetline potrebno je otvoriti sliku i u izborniku odabrati
opciju Brightness-Contrast....

<4 Brightness-Contrast X

«: Adjust Brightness and Contrast ™

| Dvorac,jpg-18 ([Dvorac] (imported))

Presets: v +E
ighness o |-l
Comast o=+ |
=) Edit these Settings as Levels

» Blending Options

& Preview Merge filter Split view

Help Reset OK Cancel

\

Pojavljuje se sko¢ni prozor Brightness-Contrast u kojem je moguce
mijenjati svjetlinu i kontrast. Ako je slika previSe tamna, potrebno je u
redu Brightness pomicati kliza€ u desnu stranu ili odabrati okretno
dugme za povecanije vrijednosti svjetline, a ako je slika previse svijetla ili
eksponirana, potrebno je kliza¢ pomicati u lijevu stranu ili okretnim
dugmetom smanijivati vrijednost svjetline.

Gotovo uvijek kombiniraju se svjetlina i kontrast, tako da je kada se
promjeni svjetlina pozZeljno mijenjati i kontrast. Kontrast se nalazi u redu
Contrast i vrijede ista pravila za kliza¢ i okretno dugme kao i kod
svjetline.

Dobro je taj sko&ni prozor pomaknuti tako da se vidi i slika koja se
obraduje u radnom prostoru, zato da se vide promjene u realnom
vremenu, §to znadi da se prilikom pomicanja kliza¢a odmah vidi rezultat
te promjene na slici. To je moguée samo ako je stavljena kvacica na
opciju Preview u lijevom kutu sko&nog prozora.

Nakon odabira Zeljene svjetline i kontrasta, pritisne se lijevom tipkom
misa dugme OK.

Slika prikazuje gradevinu koju je potrebno viSe istaknuti jer je zbog
svjetline neba i oblaka ostala malo zasjenjena.

@ srce “



GIMP ili kako besplatno fotoSopirati slike (R401)

Na Stetu oblaka i pozadine slike koji su sada preeksponirani, osvijetliena
je gradevina. Sama gradevina moze se izrezati i koristiti u nekom
budu¢em kalendaru ili ne€em slicnom. Na dolje prikazanoj slici za
svjetlinu i kontrast koriStena je vrijednost 60.

Pretvaranje slike u sive tonove

Nekad se slika zbog umjetni¢kog dojma ili zbog nekog drugog razloga
Zeli postaviti u crno-bijelu boju, tj. samo u sive tonove. U programu
GIMP to se moze izvesti na viSe nacina. Jedan od njih je da se odabere
naredba u izborniku Image - Mode - Grayscale.

Drugi nacin je da se na izborniku Colors odabere Desaturate >
Desaturate... Kada se otvori sko¢ni prozor, moguce je odabrati izmedu
pet opcija: Luminance, Luma, Lightness (HSL), Average (HSI Intensity) i
Value. Najbolje je ukljuciti opciju Preview i isprobati svaku od tih opcija
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te nakon toga odlugiti koja je najbolja. Nakon zZeljenog odabira, potrebno
je lijevom tipkom miSa odabrati dugme OK.

£l Desaturate X

Desaturate ]
Buketjpg-20 ([Buket] (imported)) -

Presets: * + (9

Luminance

Luma

Lightness (HSL)
Average (HS! Intensity)

| Value (HSV)

4

Primjer slike koja se zeli pretvoriti u sive tonove preko izbornika
Desaturate.

Za prikaz gornje slike u sivim tonovima, koristena je naredba
Luminosity

@ srce ®



GIMP ili kako besplatno fotoSopirati slike (R401)

PodeSavanje razina boja na slici

Pomocu izbornika Color Balance...(Colors - Color Balance) moguce je
podeSavati koli€inu tirkizne, purpurne ili zute boje na slici, kao i
dodavanje crvene, zelene ili plave boje.

Izbornik se sastoji od tri klizaca pomocu kojih je moguce regulirati
koli¢inu svake boje odvojeno. Osim toga, moguce je i odabrati izmedu tri
opcije na koje ¢e se odnositi to podeSavanje boja, a to su Shadows,
Midtones i Highlights. Kod ovog izbornika zanimljivo je da se kod svake
od opcija moze zasebno mijenjati koli¢ina boje, a sve zajedno se
primjenjuje na otvorenu sliku.

?"a' Color Balance X
=] Colqr Balance _ Bl
Suma.jpg-22 ([Suma] (imported))
Presets: >+ +9
Select Range to Adjust
Shadows
O Midtones
Highlights
Adjust Color Levels
cyan (D 0.0 = + Red
Magenta_ 0,0 =+ Green
Yellow _ 0,0 |— +Blue

Reset Range
Preserve luminosity
» Blending Options
Preview Merge filter Split view

Help Reset OK Cancel

Dolje prikazana izvorna slika drve¢a nakon uporabe izbornika Color
Balance moZe izgledati potpuno drugacije.
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Slika ima sada potpuno drugadiji, topliji ugodaj nakon korekcija boja te
su joj pojacane blage zelene nijanse.

Za jesensku varijantu izvorne slike, prethodna slika je odabrana i
nadogradena.
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3.5. Vjezba: Koristenje osnovnih alata

1. Otvorite sliku Pas.png.

2. Promijenite sliku tako da samo pas na slici ostane u boji, a ostali dio
slike neka bude crno-bijeli, tj. u sivim tonovima.

3. Obrezite sliku na dimenziju 2000 x 2000 px, tako da pas i dalje bude
glavni motiv na slici.

4. Spremite sliku pod nazivom Moj_pas.xcf i izvezite ju u JPEG format
pod istim nazivom.

5. Otvorite sliku Bombonijera.png.

6. Kao &to i vidite, u kutiji nedostaju tri Cokoladice. Va$ zadatak je da
,stvorite“ jednu Cokoladicu na bilo kojem praznom mjestu u kutiji.

7. Spremite sliku pod nazivom Bombonijera_2_nedostaju.xcf.
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4. Zavrsna dorada grafike i prilagodba
postavki programa

Po zavrsetku ovog poglavija polaznik ¢ce moci:

e dodati tekst na sliku

e preurediti sliku koristeci filtre

e prilagoditi sucelje viastitim potrebama.

Na bilo koju sliku otvorenu u GIMP-u moguce je dodavanje teksta te je
nakon toga potrebno spremiti. Isto tako, mnogi filtri mogu se koristiti da
se slika poboljsa, istakne ili popravi.

4.1. Dodavanje teksta

Za dodavanije teksta na sliku potrebno je otvoriti sliku na koju se zeli
dodati tekst ili izraditi novu sliku na kojoj ¢e biti tekst. Odabere se alat
Text Tool koji se nalazi u Toolboxu ili na izborniku Tools > Text i
pritisne se lijevom tipkom miSa na mjesto na slici gdje se Zeli umetnuti

tekst.

U dodatnim opcijama alata Text Tool moguce je odabrati Font preko

i a

Ire
Font
z::ns—serif

Size: 62 - +|ipx ~

Use editor window
Show on-canvas editor

B3 Antialiasing
Hinting: _Medium >

Color:

Style: | Filled v

00 -

Box: | Dynamic™
Language:

English

padajucéeg izbornika i veli¢inu fonta u viSe
ponudenih jedinica.

Takoder se odabire i boja teksta koja je po
standardnim postavkama jednaka boji
Foregrounda, a moze se i zasebno promijeniti
pod opcijom Color.

Pod opcijom Justify moze se poravnavati
tekst, a u opcijama ispod veli€ina uvlake,
prored i razmak izmedu slova.

Tekst se moZze i upisati te naknadno mijenjati,
samo ga prethodno treba oznaditi u cijelosti ili
djelomi¢no, ovisno o tome koji se dio Zeli
promijeniti.

Osim navedenih opcija, kada se pocinje pisati tekst na slici, pojavljuje se
jo§ jedan skoc&ni prozor u kojem je moguce na brZi nacin promijeniti font,
veli€¢inu fonta, podebljanje, kurziv, podcrtati tekst ili ga precrtati. Takoder
je moguce promijeniti prored, razmak izmedu slova kao i boju teksta.
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Sans-serif 29 -+ px ¥

@aszz= o0 -+00 -+

Tekst napisan u programu Gimp|

Prilikom pisanja, tekst je obrubljen okvirom koji sluzi za prikaz teksta na
slici. To znacCi da se samo ono §to je unutar okvira i prikazuje, a ako se
okvir pomakne po bilo kojoj stranici, nakon toga je potrebno korigirati i
tekst. To je korisno ako se Zeli tekst prikazati u nekim granicama na slici
pa se samo postavi okvir u te granice i pide tekst unutar okvira, nije
potrebno razmisljati je li se preslo izvan granica.

Za poniStavanje okvira s tekstom pritisne se tipka [Esc] ili se odabere
neki drugi alat u Toolboxu.

Za pomicanje teksta potrebno je odabrati alat Move Tool te nakon toga
to€no oznaditi tekst i pomaknuti ga na Zeljenu poziciju.

4.1.1. Tekst na prozirnoj pozadini

Tekst na prozirnoj pozadini koristan je za web-stranice ili ako se zeli
postaviti tekst preko neke slike. To znali da ¢e se samo vidjeti slova,
bez ikakve pozadine, dok Ce se iza slova vidjeti web-stranica ili slika na
koju se postavio tekst.

Bitno je napomenuti da ne podrzavaju svi formati slike prozirnost, tako
da se prozirne slike najéesc¢e spremaju u PNG ili GIF datoteku.

Za izradu prozirnog teksta potrebno je prvo stvoriti prozirnu sliku, a to se
radi preko izbornika File > New... U sko¢nom prozoru Create a New
Image pritisne se lijevom tipkom miSa na oznaku + pokraj teksta
Advanced Options. U padaju¢em izborniku Fill with potrebno je
odabrati Transparency. Nakon toga, ako vec nije odabrana, odabere se
Zeljena dimenzija, te se pritisne na dugme OK.

Nakon $to se upiSe Zeljeni tekst, ostatak slike mozZe se ru¢no obrezati ili
preko alata Autocrop Image, koji se nalazi u izborniku Image.

Tekst na transparentnoj pozadinil.

Na kraju je potrebno sliku izvesti iz programa u neki format koji podrzava
prozirnost, u gornjem slucaju je to PNG. Tekst je na gornjoj slici
postavljen na tri pravokutnika razliCite boje te se moze vidjeti da, bez
obzira na boju pozadine, tekst ostaje proziran.
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4.2. Uporaba filtara

Filtri sluze za promjenu izgleda neke slike, a program GIMP nudi preko
100 razlicitih vrsta. Jako se jednostavno koriste. Otvori se slika i samo
se preko izbornika Filters primijeni neki od filtara.

S obzirom na to da se vrac¢a u modu starinski izgled slika, najlaksi nacin
za pretvaranje obi¢ne slike u sliku sa starinskim izgledom je pomoc¢u
filtra Old Photo. Otvori se slika kojoj se zeli dati starinski izgled i
odabere naredba iz izbornika Filters - Decor - Old Photo.

« Old Photo X
Defocus Lo N
Zanimljivosti i napomene
Bordersize 20 - +
Sepia Uvijek je dobro oznaditi
Mottle kvacicom polje Work on

copy kod svih filtara koji to

£ Work on copy nude. Time se osigurava da

Load Saved Settings Save Settings izvorna slika bude
nepromijenjena, tj. kao u
Help 0K Reset ™ T pocetnom stanju, a filtar se
primjenjuje automatski na
njenoj kopiji.

Pojavljuje se sko¢ni prozor Old Photo u kojem je moguée odabrati
dodatne opcije filtra. Preporuka je ako se prvi put koristi neki filtar, da se
samo pritisne na dugme OK te se nakon toga moze vidjeti rezultat filtra
po standardnim postavkama. Uvijek se moZze ponoviti postupak i
odabrati drugacije postavke u tom izborniku.

Na gornjoj slici nalazi se izvorna slika, a na donjoj se nalazi slika hakon
koriStenja filtra Old Photo.
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Na isti nacin koriste se i ostali filtri u toj skupini, otvori se slika i primjeni
filtar. Dolje je naveden primjer koristenja filtra Slide... u skupini Decor.

Gore je prikazana izvorna slika koja se pomocu filtra pretvorila u ,sliku
na filmu®, tj. dodan joj je okvir filma.
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Filtri se mogu osim na kompletnim slikama koristiti i na dijelovima slika,
selekcijama, tekstu te ostalim grafi¢kim objektima.

Za koristenje filtra na selekcijama, postupak je isti kao i kod cijele slike,
samo Sto se prije toga treba oznaciti dio na koji se zeli primijeniti neki
filtar.

Na dolje prikazanoj izvornoj slici zeli se da pozadina slike izgleda kao
prasina. Prvo je potrebno oznaciti pozadinu slike te nakon toga
primijeniti na njoj odredeni filtar.
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To se postize uz pomoc filtra koji se nalazi u izborniku Filters > Decor
- Fog. Potvrdene su standardne postavke pritiskom na dugme OK.

Cesto je potrebno i neki tekst malo obogatiti, da nije suhoparan, pa se
najcescée koristi neka vrsta sjene ili neki drugi proizvoljan efekt koji se
dodaje preko filtra.

Prvo je potrebno napisati tekst te nakon upisa upotrijebiti filtar Drop
Shadow koji se nalazi na izborniku Filters > Light and Shadow.

| Drop Shadow X
(= Drop Shadow .
= Tekst napisan u programu Gimp-28 ([Untitled])
Presets: v +
| booo]-[+
6,000 — + 21
B 10,00 |-+
Grow shape Circle
Growrsdis o -
color [N, -
Opacty 0,500 =+
Clipping Adjust ¥
» Blending Options
Preview Merge filter Split view
Help Reset OK Cancel

Zanimljivosti i napomene

U sko€nom prozoru Drop Shadow moguce je promijeniti poziciju sjene,
Skocni prozor Drop Shadow radijus zamagljenja, boju sjene te neprozirnost. Nakon odabranih

obino se otvara u pozadini vrijednosti, potrebno je pritisnuti dugme OK.
ij. iza glavnog prozora
programa pa ga je potrebno
odabrati s programske
trake.
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GIMP je besplatan graficki alat za
stvaranje i obradu rasterske grafike.

4.3. Prilagodba programa

Postavke programa moguce je prilagoditi na vrlo jednostavan nadcin,
preko izbornika Edit > Preferences. Otvara se skoCni prozor
Preferences u kojem korisnik moze promijeniti gotovo sve postavke.

U prvom izborniku, System Resources postoji moguénost promijene
minimalnog broja poniStavanja, tj. Povijesti preko opcije Minimal number
of undo levels. Tu opciju najbolje je postaviti na 30 ili viSe. Ispod te
opcije nalazi se opcija Maximum undo memory koju se takoder
preporucuje postaviti na vise od 150 MB. Na dolje prikazanoj slici te
dvije opcije oznagene su crvenim okvirom.

Ako se Zeli promijeniti zadana postavka veliine prazne slike prilikom
njenog stvaranja, odabere se izbornik Default Image. Ovaj izbornik jako
sli€i izborniku koji se pojavljuje kada se stvara nova slika, a upravo je i to
cilj, da se postave nove zadane postavke za veli€inu slike, rezoluciju,
boju pozadine itd.

Kada se Cesto koristi neka opcija ili alat u GIMP-u, radi uStede vremena
koriste se tipkovni pre¢aci, bilo za odabir nekog alata ili neke akcije.
Tako je, primjerice, za kopiranje odredenog elementa na slici tipkovni
precac [Ctrl]+C, Sto Stedi vrijeme u odnosu na odabir te iste naredbe
preko izbornika Edit > Copy. Upravo takve skracenice za pojedinu
akciju moguce je mijenjati preko izbornika Interface. Potrebno je
pritisnuti na dugme Configure Keyboard Shortcuts nakon kojeg se
pojavljuje skocni prozor u kojem je moguce dodijeliti gotovo svim
akcijama u GIMP-u odgovarajuci tipkovni pre€ac, ako ve¢ ne postoji.
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«d Preferences X

System Resources
& Color Management

™lmage Import & Bxport  Resource Consumption

Tool Options Minimal number of undo levels: 5 -+
v B Default Image
# Default Grid Maximum undo memory: 4147256 — +  Kibibyte ¥
~ Hinterface Tile cache size: 1658902 — +  Kibibyte ¥
ETheme
. . . |+ .
Blicon Theme Maximum new image size: 128 Mebibyte ¥
EToolbox Swap compression: Best performance A
EDialog Defaults Number of threads to use: 12 - +
£ Help System
“IDisplay Image Thumbnails
EWindow Management Size of thumbnails: Normal (128x128) -

~ [¥|Canvas Interaction

[EModifiers

[@Isnapping Document History
~ &image Windows Keep record of used files in the Recent Documents list ()

Maximum filesize for thumbnail 4 = +  Mebibyte

[FlAppearance
ETitle & Status
¥ ©Input Devices
“Input Controllers
» S Folders

Help Reset oK Cancel
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4.4. Vjezba: Dodavanje teksta i uporaba filtra

1. Stvorite novu sliku dimenzije 7000 x 700 px, 300 ppi X i Y rezolucije,
prozirne pozadine.

2. Otvorite sliku Crvene_oci.png.

3. Pomocu filtra Red Eye Removal obriSite na slici pojavu crvenih
ociju, koja se pojavljuje prilikom uporabe blica fotoaparata. Potrebno
je prvo oznaciti crveno oko te nakon toga primijeniti filtar.

4. Upisite tekst ,Primjer slike bez crvenih ogijul®, plave boje, veli€ine 26
px, fonta Arial Bold i smjestite ga tako da pocinje na koordinatama
70 px okomito i 10 px vodoravno.

5. Spremite sliku pod nazivom Normalne_oci.xcf.
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Prilog 1. — Opis izbornika

Program GIMP pruza velik broj moguc¢nosti, a do svih njih moze se doci
preko izbornika u srediSnjem radnom prozoru. Naj¢e$ce koridtene
naredbe ili alati nalaze se na brzo dostupnim mjestima u Toolboxu ili u
desnom prozoru s dodatnim opcijama, dok je ostale potrebno odabrati
preko izbornika.

Izbornik File sli¢an je i kod drugih programa, a najosnovnije naredbe za
pocetnike u njemu su:

o New - naredba za stvaranje nove slike
¢ Open - otvaranje slike u programu
e Save — spremanje slike

o Save As — spremanje slike u formatu XCF koji sluzi za kasnije
editiranje slike u programu GIMP

o Export — sluzi za spremanje slike u razliitim datotecnim
formatima kao $to su TIFF, JPG, PNG, GIF, PDF, BMP i drugi

e Close View — zatvara trenutno otvorenu sliku
¢ Quit — izlaz iz programa.
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Izbornik Edit sadrzi jako korisne naredbe. Neke od njih su:

Undo, naredba koja briSe zadnju akciju (skracenica za ovu
akciju je [Control] + [Z]) ili Undo History u kojem se Cuvaju sve
prijasnje radnje

Redo — vrac¢a zadnju akciju

Cut ([Control] + [X]) — sluzi za izrezivanje

Copy ([Control] + [C]) — naredba za kopiranje

Paste ([Control] + [V]) — sluzi za lijepljenje

Preferences, u kojem se nalaze postavke za prilagodavanje
radnog prostora te razna druga podeSavanja.

L

~ 0 H*k

2

GEGI
s

& s:

Undo History
Cut
Copy

4 [Untitled]-1.0 (RGB color 8-bit non-linear integer, GIMP built-in sRGB, 1 layer) 1920x1080

File Edit Select View Image Layer Colors Tools Filters Windows Help

=f
|
ctrlex [B5]
cul+C A

Copy Visible  Shift+Ctrl+C

Paste

Ctrl+V

Paste In Place Ctri+Alt+V

Paste as

Buffer

Clear

B Fill with FG Color
L] Fill with BG Calor
[T Fill with Pattern

Preferences

Input Devices
Keyboard Shortcuts
Modules

Units

»

3
Delete |,
Ctrl+,
Ctrl+.
Ctrl+;

]

E{I\\\"WDQ\I|\|I\|O|\\\|
o

0

‘\\\I\\l*l

‘ oor\:| oo
[ T T (T A T A T AR

oow|
1

@ srce 7



GIMP ili kako besplatno fotoSopirati slike (R401)

Izbornik Select sluzi za dodatne opcije kod oznacenog dijela slike ili
kompletne slike. Neke od koristenijih opcija su:

All — sluzi za ozna€avanije cijele slike
None — briSe selekciju sa slike

Invert — naredba koja radi obrnuto oznacavanje od trenutno
oznacéenog djela, 8to znadi da ¢e se sve $to je izvan selekcije
nakon odabira ove naredbe nalaziti unutar selekcije i obrnuto

Float — tzv. privremeni layer, u kojem se nalaze svi objekti prije
nego se poc¢nu obradivati, dakle, kada se bilo koji element zalijepi u
program GIMP, on se nalazi u float layeru.

| [Untitled]-1.0 (RGB color 8-bit non-linear integer, GIMP built-in sRGB, 1 layer) 1920x1080 -
File Edit Select View Image Layer Colors Tools Filters Windows Help
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Selection Editor
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Sample
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Izbornik View ima jako puno korisnih mogucnosti za pregled slike na
kojoj se radi. Neki od njih su:

Dot for Dot — ukljucuje se prilikom obrade slike za web i ako se

obraduju slike za ispis, potrebno je onemoguditi tu opciju tako da se
slika vidi u svojoj punoj veli€ini

Zoom — koristan za priblizavanje i smanjivanje kompletne slike ili

nekog njezinog dijela

Show Grid — prekriva sliku u radnom prostoru mrezom koja sluzi

za poravnavanje elemenata na slici

Snap to Grid — pona$a se kao magnet te olakSava poravnavanje

elemenata po slici

Show Rulers — prikazuje ili sakriva ravnalo u programu.

«d [Untitled]-1.0 (RGB color 8-bit non-linear integer, GIMP built-in sRGB, 1 layer) 1920x1080

File Edit Select View Image Layer Colors Tools Filters Windows Help

New View
. 210 Show All
' ® B @ Dot for Dot
% & E| Zoom (272%)
& & Flip & Rotate (0°)

~O0E %

ﬁ, w, Center Image in Window
@ Shrink Wrap
E O Fullscreen

= Move to Screen
GEGL Operation

@ sample averag Navigation Window

'adius Display Filters...

Color Management

™ Show Selection

& Sample merged

[ Show Layer Boundary

»

»
Shift+)
Ctrl+)
F11

»

»

Ctrl+T

™ Show Guides Shift+Ctrl+T

J Show Grid

@ Show Sample Points

[ Snap to Guides

[ Snap to Grid

O Snap to Canvas Edges

O Snap to Active Path

[ Snap to Bounding Boxes

O Snap to Equidistance
Padding Color

™ Show Menubar

™ Show Rulers

™ Show Scrollbars

™ Show Statusbar

Shift+Ctrl+R

\‘O\‘I|\‘\‘I|5p|\‘\‘\|

59



GIMP ili kako besplatno fotoSopirati slike (R401)

Izbornik Image sluZi za promjene na slici kako bi se pobolj8ale boje,
veliCina, polozaj itd. Korisne naredbe su:

- Duplicate — izraduje jednaku kopiju aktualne slike te obrada kopije
ne utjeCe na originalnu sliku

- Mode — mijenja prikaz slike u RGB ili crno-bijelom modu
- Transform — rotira ili zrcalno okrece sliku

- Canvas Size — omogucuje kreiranje dodatnog prostora izvan slike
koji je koristan ako se Zeli dodati okvir ili tekst van slike

- Scale Image — mijenja broj piksela neke slike.
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Izbornik Layer koristi se prilikom umetanja dodatnih slika na ve¢
postojanu sliku, kod umetanja teksta, crteza i ostalih elemenata. Korisne
naredbe su:

- New Layer — dodaje se novi prazni layer na sliku odmah iznad
aktivnog layera

- Duplicate Layer — dodaje se novi layer, potpuno jednaka kopija
aktivnog layera

- Delete Layer — briSe se aktivan layer.
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Izbornik Colors sadrzi velik raspon alata za podeSavanje boja na nekoj
fotografiji, slici ili crteZzu. Koriste se alati ovisno o potrebi, a neki od

najcesce koristenih su:

Color Balance sluzZi za povecanije ili smanjivanje koli€ine

tirkizne, purpurne ili Zute boje

Hue-Saturation omogucéava povecanije ili smanjivanje nijanse

neke boje, svjetline boje ili zasi¢enja

kontrasta neke slike.

Levels kontrolira sjene, svjetlinu i Sumove na slici
Curves je alat koji sluzi za promjenu boja, osvjetljenja i

File Edit Select View Image Llayer Colors Tools
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Izbornik Tools takoder je dostupan u Toolbox Windowu s lijeve strane
programa u Single-Window Modu. Koriste se gotovo svi alati iz svake
skupine. Ovaj izbornik koristan je ako se zatvori Toolbox Window radi
dobivanja veéeg prostora u programu.
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Izbornik Filters sadrzi veliku koli€inu raznih filtara koji se koriste za
poboljSanje neke fotografije ili za stvaranje unikatne slike. Filtri u ovom
izborniku mogu se primijeniti na cijelu sliku, /ayer ili samo selekciju na
odredeno; slici.
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Izbornik Windows pruZa pristup velikom broju dijaloga ili panela koji su
dostupni u podizborniku Dockable Dialogs. Velika novost u odnosu na
verziju GIMP-a 2.8. je Single-Window Mode koji spaja tri odvojena
panela u jedan. Za pocetnike je preporucljivo da koriste Single-Window
Mode zbog lak8eg shalaZenja u programu.
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Izbornik Help nudi dodatne informacije i pomo¢ programerima koji zele
razvijati program, kao i obi¢nim korisnicima.

- GIMP Online - podizbornik koji obi¢nim korisnicima i
programerima nudi pomoc i dokumentaciju u vezi s programom.
Takoder je moguce preuzeti sadrzaj Helpa na lokalno ra¢unalo i
pregledavati ga bez koristenja interneta.

- About — sadrzi informaciju o verziji GIMP-a instaliranoj na
raCunalo.
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Literatura

GIMP tutoriali, http://www.gimp.org/tutorials
GIMP for Absolute Beginners, Jan Smith with Roman Joost
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